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Getting Started 

 

Welcome to AlarmCAD! 

AlarmCAD version 4 (VR4) is the latest in fire alarm system design software from M.E.P.CAD. 
This powerful stand-alone computer-aided design system employs familiar elements of 
M.E.P.CAD's best-selling AutoSPRINK® fire sprinkler design program, along with a wide array 

of features specifically tailored to alarm system design. 

AlarmCAD VR4 redefines the possibilities of CAD technology, providing you with essential tools 
to explore new ideas and bring your concepts to reality. It is advanced and flexible, yet also 
practical and cooperative, making design unflinchingly fun. And we're not yet done. M.E.P.CAD 
is continually adding new features and exciting enhancements to keep AlarmCAD VR4 on the 

cutting edge. 

Real automation for fire alarm design software -- this is the future of computer-aided design. 
M.E.P.CAD brings it to your desktop, ready-made, prepackaged, and just right for the job. 
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System Requirements 

 

Minimum System 

To use AlarmCAD VR4, your PC needs to meet the following minimum specifications: 

¶ Intel® or compatible CPU 
¶ Microsoft Windows® 98, NT 4.0 or later, 2000, ME, or XP 
¶ 128 MB of RAM 
¶ Color display adapter with 32 MB of RAM set to 800x600 screen resolution 
¶ 150 MB available hard disk space 

Recommended System 

Note that the above requirements are the minimum. For better performance when using 

AlarmCAD VR4, your PC should meet or exceed the following suggested specifications: 

¶ 1.5 GHz processor or faster 
¶ Microsoft Windows® 2000 or XP 
¶ 512 MB (or more) of RAM 
¶ High Color accelerated display adapter set to at least 1024x768 screen resolution 
¶ Nvidia® GeForce 3TM or GeForce 4 with 64 MB or more of video RAM 
¶ 19" or larger high resolution monitor 
¶ 300 MB or more of available hard disk space for drawing and work data 
¶ CD-ROM drive 

¶ Three-button mouse with scroll wheel 
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Installation 

 

You must first have Windows 98, NT, 2000, ME or XP loaded and operating properly on your 
computer before attempting to install. AlarmCAD will not operate on the older Windows 3.1 or 
3.11. Prior to installation, please remove all diskettes from your system floppy drive and 

terminate all active applications. 

For successful operation of your AlarmCAD software, the Sentinel Super Pro hardware key 
contained in this release must be placed in the parallel port or USB port of your computer. As 
with all hardware installation, please ensure that you properly ground yourself to prevent static 
shocks. 

Do the following to install a parallel port hardware key:  

¶ Completely power down your system. 
¶ If you have a local printer that plugs into the parallel 

port, turn off the printer, then disconnect it from the 
parallel port. 

¶ Plug the key into the parallel port. Tighten the lugs 
to secure it. Be careful not to overtighten lugs. 

¶ If you have a local printer that plugs into the parallel 
port, plug the printer cable directly into the 
hardware key. It should be invisible to any 
operations of your computer while in place. The key 
driver software installed with AlarmCAD will locate the hardware key upon program 
activation. 

¶ Turn your system back on, and continue with the software installation. 

Note: If you are using a local printer, rather than a network printing device, and your printer 

normally connects to your system's parallel port, in order to use AlarmCAD and have it 
recognize your hardware security key, you must have the printer turned on and active (i.e. not in 

power-saving mode). 

Do the following to install a USB port hardware key:  

¶ Plug the key into an available USB port. 
¶ Once your system acknowledges that new 

hardware has been added, continue with the 

software installation. 

Because AlarmCAD distribution files are compressed, you must run the setup program to place 
files on your hard disk. You will follow the same steps whether you're installing AlarmCAD for 

the first time or as a new (upgrade) version. 

Insert the AlarmCAD CD into your CD-ROM drive and wait for the installation menu to appear. 
(If Autorun is disabled, double-click the My Computer icon on the desktop then double-click 



AlarmCAD 

4 

your CD-ROM drive icon.) Choose from the installation options and follow the on-screen 

directions. 
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Optimizing Your System 

 

The following are a few helpful tips that may help improve the overall performance of AlarmCAD 

VR4, depending on your particular system configuration: 

¶ Get more RAM to improve overall performance. We recommend 128 MB for satisfactory 
performance in AlarmCAD VR4; however, if you tend to work with very large drawings, 
additional RAM will be very beneficial. 

¶ Save your work periodically. This releases memory allocated for Undo/Redo objects. 
¶ Use the most recent release of Microsoft Windows® possible (Windows NT 4.0 or higher 

or Windows XP). AlarmCAD VR4 runs noticeably faster in more recent releases of 
Windows. Windows 95 is not recommended. 

¶ Close other applications while using AlarmCAD VR4 to free up the maximum amount of 
system resources. 

¶ Turn off snaps that are not necessary. This will improve cursor performance. 
¶ Turn off any unneeded layers. 

¶ Turn off snapping on layers needed only for reference. 
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Key Terms 

 

Following is a brief glossary of key terms and concepts used in fire alarm system design. 

Addressable Device: A fire alarm system component with discrete identification that can have 

its status individually identified or that is used to individually control other functions. 

Alarm: A warning of fire danger. 

Alarm Signal: A signal indicating an emergency requiring immediate action, such as a signal 

indicative of fire. 

Annunciator: A unit containing one or more indicator lamps, alphanumeric displays, or other 
equivalent means in which each indication provides status information about a circuit, condition, 

or location. 

Authority Having Jurisdiction: The organization, office, or individual responsible for approving 

equipment, an installation, or a procedure. 

Detector: A device suitable for connection to a circuit having a sensor that responds to a 

physical stimulus such as heat or smoke. Types of detectors include the following: 

¶ Air Sampling-Type Detector: A detector that consists of a piping or tubing distribution 
network that runs from the detector to the area(s) to be protected. An aspiration fan in 
the detector housing draws air from the protected area back to the detector through 
sampling ports, piping, or tubing. At the detector, the air is analyzed for fire productions. 

¶ Combination Detector: A device that either responds to more than one of the fire 

phenomenon or employs more than one operating principle to sense one of these 
phenomena. Typical examples are a combination of a heat detector with a smoke 
detector or a combination rate-of-rise and fixed-temperature heat detector. 

¶ Fire-Gas Detector: A device that detects gases produced by a fire. 
¶ Fixed Temperature Detector: A device that responds when its operation element 

becomes heated to a predetermined level. 
¶ Flame Detector: A radiant energy-sensing fire detector that detects the radiant energy 

emitted by a flame. 
¶ Heat Detector: A fire detector that senses heat produced by burning substances. (Heat 

is the energy produced by combustion that causes substances to rise in temperature.) 
¶ Line-Type Detector: A device in which detection is continuous along a path. Typical 

examples are rate of rise pneumatic tubing detectors, projected beam smoke detectors, 
and heat-sensitive cable. 

¶ Projected Beam-Type Detector: A type of photoelectric light obscuration smoke 

detector wherein the beam spans the protected area. 
¶ Radiant Energy-Sensing Fire Detector: A device that detects radiant energy (such as 

ultraviolet, visible, or infrared) that is emitted as a product of combustion reaction and 
obeys the laws of optics. 

¶ Rate Compensation Detector: A device that responds when the temperature of the air 
surrounding the device reaches a predetermined level, regardless of the rate of 
temperature rise. 
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¶ Rate-of-Rise Detector: A device that responds when the temperature rises at a rate 

exceeding a predetermined value. 
¶ Spark/Ember Detector: A radiant energy fire detector that is designed to detect sparks 

or embers, or both. These devices are normally intended to operate in dark 

environments and in the infrared part of the spectrum. 

Fire Alarm Control Unit (Panel): A system component that receives inputs from automatic and 

manual fire alarm devices and might supply power to detection devices and a transponder(s) or 
an off-premises transmitter(s). The control unit might also provide transfer of condition to relays 
or devices connected to the control unit.  The fire alarm control unit can be a local fire alarm 

control unit or master control unit. 

Fire Alarm Signal: A signal initiated by a fire alarm-initiating device such as a manual fire alarm 
box, automatic fire detector, waterflow switch, or other device whose activation is indicative of 

the presence of a fire or fire signature. 

Fire Alarm System: A system or portion of a combination system consisting of components 

and circuits arranged to monitor and annunciate the states of fire alarm or supervisory signal-

initiating devices and to initiate the appropriate responses to those signals. 

Initiating Device: A system component that originates transmission of a change of state 
condition, such as in a smoke detector, manual fire alarm box, or supervisory switch. Types of 

initiating devices include the following: 

¶ Analog Initiating Device (Sensor): An initiating device that transmits a signal indicating 

varying degrees of condition as contrasted with a conventional initiating device, which 
can only indicate an on/off condition. 

¶ Nonrestorable Initiating Device: A device whose sensing element is designed to be 

destroyed in the process of operation. 
¶ Restorable Initiating Device: A device whose sensing element is not ordinarily 

destroyed in the process of operation. Restoration can be manual or automatic. 
¶ Supervisory Signal-Initiating Device: An initiating device such as a valve supervisor 

switch, water level indicator, or low-air pressure switch on a dry-pipe sprinkler system 
whose change of state signals an off-normal condition and its restoration to normal of a 
fire protection or life safety system; or a need for action in connection with guard tours, 

fire suppression systems or equipment, or maintenance features of related systems. 

Manual Fire Alarm Box: A manually operated device used to initiate an alarm signal. 

Notification Appliance: A fire alarm system component such as a bell, horn, speaker, light, or 

text display that provides audible, tactile, or visible outputs, or any combination thereof. Types of 
notification appliances include the following: 

¶ Audible Notification Appliance: A notification appliance that alerts by the sense of 

hearing. 
¶ Visible Notification Appliance: A notification appliance that alerts by the sense of 

sight. 

Notification Appliance Circuit: A circuit or path directly connected to a notification 

appliance(s). 
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Power Supply: A source of electrical operating power including the circuits and terminations 

connecting it to the dependent system components. 

Signaling Line Circuit: A circuit or path between any combination of circuit interfaces, control 
units, or transmitters over which multiple system input signals or output signals, or both, are 

carried. 

Signaling Line Circuit Interface: A system component that connects a signaling line circuit to 

any combination of initiating devices, initiating device circuits, notification appliances, notification 

appliance circuits, system control outputs, and other signaling line circuits. 

Smoke Alarm: A single or multiple station alarm responsive to smoke. 

Smoke Detection: A general term for various means of detecting the smoke from a fire. 

Methods of smoke detection include the following: 

¶ Ionization Smoke Detection: The principle of using a small amount of radioactive 

material to ionize the air between two differentially charged electrodes to sense the 
presence of smoke particles. Smoke particles entering the ionization volume decrease 
the conductance of the air by reducing ion mobility.  The reduced conductance signal is 
processed and used to convey an alarm condition when it meets present criteria. 

¶ Photoelectric Light Obscuration Smoke Detection: The principle of utilizing a light 

source and a photosensitive sensor onto which the principal portion of the source 
emissions is focused. When smoke particles enter the light path, some of the light is 
scattered and some is absorbed, thereby reducing the light reaching the receiving 
sensor. The light reduction signal is processed and used to convey an alarm condition 
when it meets preset criteria. 

¶ Photoelectric Light-Scattering Smoke Detection: The principle of utilizing a light 

source and a photosensitive sensor arranged in a manner so that the rays from the light 
source do not normally fall onto the photosensitive sensor. When smoke particles enter 
the light path, some of the light is scattered by reflection and refraction onto the sensor. 
The light signal is processed and used to convey an alarm condition when it meets 

preset criteria. 

Supervisory Signal: A signal indicating the need of action in connection with the supervision of 
guard tours, the fire suppression systems or equipment, or the maintenance features of related 

systems. 

Zone: A defined area within the protected premises. A zone can define an area from which a 

signal can be received, an area to which a signal can be sent, or an area in which a form of 

control can be executed. 
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Help 

Help Menu 

 

The Help menu opens from the Main Menu bar, offering access to the AlarmCAD Help table of 

contents, the tutorial video table of contents, the AlarmCAD Help index, support contact 
information and the Tip of the Day. 

Help Topics: Select this to open the AlarmCAD help window with the 

table of contents displayed. Select topics in the left-hand pane; view 
topics in the right-hand pane. In help topics, words shown in blue and 
underlined and items listed under "Related Topics" are links to 
additional information; buttons in help topics also provide links to other 
pages. Every topic in the help file has a link to the Main Help Hub page 

as well. 

Support: When you've reached the end of your rope (or perhaps even before then), it's time to 
contact tech support. We work with enough software ourselves to know the value of a little 
inside information before that pricey new PC goes flying through a window. Select this function 

to show email and phone contact information for M.E.P.CAD. 

Tip of the Day: This window will usually open when you first open AlarmCAD. It offers 

information about AlarmCAD that you might not otherwise be able to find out quickly. You can 
also open this window by selecting it here. 

Getting Started Guide: Provides an introduction and useful information about AlarmCAD, 

including the program's layout and design. Walk-through exercises are also available in in this 

guide. 

About AlarmCAD...: View AlarmCAD credits, version information and contact information. 
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About AlarmCAD 

 

Access: Help: About AlarmCAD... 

View current AlarmCAD credits, 
version information and contact 
information in the About AlarmCAD 

dialog box. 

Click on the weblink in the lower left 
corner of this dialog box to visit 

M.E.P.CAD's website. 

Click on the green icon in the lower 
right corner of the dialog box to view 
information about the current version 

of the Symmetrica© CAD engine. 

Click on the Check for product 
updates button to manually check for 

program updates.  
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Using Online Help 

 

AlarmCAD features both context-sensitive and menu-accessible help files. Though most 
aspects of AlarmCAD are easily discerned from their title, familiarity with Windows software, or 
working knowledge of sprinkler system equipment, there are subtle attributes that the casual 
user might not discover. The help files document these advanced features in addition to basic 

operations. 
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Help Index 

 

Access: Help: Help Index 

The Help Index is a useful search tool when looking for additional 

information on a specific issue. The help window will open with the 
index displayed when you select this function from the Help 

menu; you can display it any other time the help window is open 
by clicking the Index tab in the left-hand pane of the help window. 

To use this index, do the following: 

¶ Find the desired keyword in the index pane. Use the scroll 
bar to move up and down the list if needed. 

¶ Either highlight the desired keyword and click Display, or 

double-click on the desired keyword. The associated topic 
will be displayed in the right-hand pane of the help 
window. 

If more than one topic is associated with a particular index 
keyword, a dialog box will appear for selection of a specific topic. 

Do the following: 

¶ Click on the desired topic and click Display, or double-

click on the desired topic. 

OR 

¶ If none of the topics are the one you need, click Cancel. 
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Help Topics 

 

Access: Help: Help Topics 

The Help Topics function is one of the main methods of 

accessing online help for AlarmCAD. This opens the help window 
with the table of contents displayed; you can display it any other 
time the help window is open by clicking the Contents tab in the 

left-hand pane of the help window. 

To use this table of contents, do the following: 

¶ Find the desired topic in the Contents pane. Double-click 

on a book icon to show a list of topics under that general 
category. (The currently displayed topic will be highlighted 
in the list.) 

¶ Click on the desired topic. It will be displayed in the right-
hand pane of the help window. 

The help TOC will also be displayed whenever the help window is 
opened using context-sensitive help procedures. 
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Support 

 

Access: Help: Support... 

Technical Support is available for users who 

need it (see right image). 

Contact information for M.E.P.CAD's helpful 
customer support staff is provided in the 
Support dialog box. 
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Tip of the Day 

 

Access: Help: Tip of the Day 

The Tip of the Day is an easy way to learn just a little 

more about AlarmCAD. 

This window will usually open when AlarmCAD is 
started; it is also accessible from the Help menu. 

Use the Tip of the Day window as follows: 

¶ Click Previous Tip or Next Tip to move 
backward or forward through the Tip of the 
Day file. 

¶ To have this window open each time you run AlarmCAD, make sure the Show tips box 
is checked. 

¶ Click Close to close the window. 
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Basic Procedures 

Windows Basics 

 

The AlarmCAD interface is similar to that of most Windows applications. The program displays a 
menu bar along the top of the screen with 14 menu titles. Selecting a command from one of 
these menus will perform an action or display a submenu or dialog box. 

Additional commands and procedures are executed by clicking icons on toolbars, each of which 
is activated or deactivated from the View menu. 

Details follow on basic Windows functionality in AlarmCAD. 

Menus 

The main menu bar is at the top of the AlarmCAD window, offering access to the program's 
major functions. 

 

To display a menu, simply click on the desired title or press [Alt] followed by the underlined letter 

in the menu name. For example, pressing [Alt]-F accesses the File menu. 

In any displayed menu, items are generally grouped 
according to function or the types of operations they 
perform. To select a menu item, click on the desired 
item with the mouse, use the arrow keys to navigate to 
the desired item and press [Enter], or press the letter 
key that corresponds to the underlined character (if 
any) in the title of the desired item. 

Many menu items have keyboard shortcuts listed after 
them. These shortcuts are available even if the menu 
is not displayed. For example, pressing [Ctrl]-N will 
open a new drawing. M.E.P.CAD strongly 
recommends learning and using as many keyboard 
shortcuts as you can, because you will save time 
accessing functions directly from shortcuts instead of 
opening menus and selecting them from there. 

Menu items with an ellipsis (...) after them typically 
open dialog boxes, while menu items with a triangle 
after them open submenus. If the item displays a 
submenu, use any of the techniques above to choose 

entries in the submenu. 












































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































